
Centreline Deviation Software Manual                                                                                             

 

1 14/02/2014 
 

 

 

 

Centreline Deviation Software 
User Guide 

  



Centreline Deviation Software Manual                                                                                             

 

2 14/02/2014 
 

Contents 

 
Centreline Deviation Testing System ................................................................................................................................ 3 

Software Overview ............................................................................................................................................................ 4 

How to setup your equipment for live testing ............................................................................................................. 4 

Auto Configuration ....................................................................................................................................................... 4 

Live Data ....................................................................................................................................................................... 5 

How to view Post Processed Data ................................................................................................................................ 6 

Re-scanning Data .......................................................................................................................................................... 6 

Test Procedure & Setup ................................................................................................................................................ 6 

Obtaining Results .......................................................................................................................................................... 8 

Testing environments ................................................................................................................................................... 8 

Analysing Results .......................................................................................................................................................... 8 

Results from Last Recorded Test .................................................................................................................................. 9 

Collective Results ........................................................................................................................................................ 10 

Removing Test Lines ................................................................................................................................................... 12 

Exporting Test Results ................................................................................................................................................ 12 

Glossary of Terms ............................................................................................................................................................ 13 

Centreline Deviation ................................................................................................................................................... 13 

Checking Software Version ......................................................................................................................................... 14 

Contact details ............................................................................................................................................................ 14 

 
 

  



Centreline Deviation Software Manual                                                                                             

 

3 14/02/2014 
 

Centreline Deviation Testing System 
 
Manufactures need to test the ability of their vehicles to track in a straight line, to make sure that the vehicle does 
not “pull” to the left or right. 
 
The ability to track in a straight line also needs to be verified under the influence of external conditions such as: 
 

 Side winds. 

 Suspension Geometry errors. 

 Deviation under brake test. 

 Deviation during lane change test. 
 
The Racelogic Centreline Deviation Software helps measure this accurately. 
 
In order to establish the vehicle heading to base the deviation calculation on data is sampled in the short time before 
the centreline deviation test. This means that the test engineer can drive in any direction across the test pad, as long 
as the vehicle is kept in a straight line before letting go of the steering wheel. 
 
This is useful for different proving ground layouts, and means that tests can take place in a variety of locations. To 
maintain accuracy, any runs in which the heading before the start of the test was not within the user-defined 
tolerances during the averaging period are highlighted. 
 

Test Procedure Example 
 

1. The test driver sets the start or end line and centreline distance.* 
2. Test driver proceeds to the start position, attempting to maintain a constant heading. 
3. The centre line is calculated during the averaging period (if the deviation is too high 

the test is aborted) 
4. The centre line and start speed are then updated on the screen, the status displays 

‘test started’ and the software beeps. 
5. During the test the centre line distance, centre line deviation, end speed, and average 

speed are updated every sample and shown in the live window. 
6. The tests ends on a GPS end line or pre-defined centreline distance, and the final 

results are displayed. 

 
 
 
 
 

 
 
*Note Speed Sensor Units can only use a digital Input for the Start condition and centreline distance for the end of 
the test  
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Software Overview 
 
Racelogic Centreline Deviation Software is a stand-alone application specifically designed for Racelogic customers 
who are performing centreline deviation tests using a VB3i or VBSS100. 
The software is able to process both live serial data and recorded VBO files in order to generate results from either 
brake trigger or distance tests.  This allows customers to perform multiple tests and view the results in a visually 
clear manner. 
The software is more configurable, clearer and visual than the Report Generator centreline deviation results in VBOX 
Tools. 
 

How to setup your equipment for live testing  

To generate results from live serial data the software 
must be toggled to be Online under the Options tab. 
 

 

 
 

Live data requires your software to be able to 
communicate with your VBOX.  To do this a 
RLCAB001 serial cable must be connected to the 
serial port of your VBOX.  This connection will be 
assigned a COM port by your computer.  This 
relevant COM port must then be assigned under 
the Options tab. 

 
Auto Configuration 

To get the most accurate and representative test results, the VBOX3i (or equivalent RL unit) should be setup in its 
most dynamic state.   
This can be configured automatically through connecting the unit up to the software.   
With the VBOX unit connected up to the software go to the Options tab, select Configure Hardware.   

 

 

 

 

 

 

 

 

 
You should see a confirmation window pop-up once your unit 
has been successfully configured. 
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Live Data 

When the software is in online mode the Current Data window on the right hand side of the screen can be used as a 
quick reference to see whether your setup is successful, and whether the system is ready to start performing brake 
stop tests. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
CAN channels can be selected for viewing using the CAN Set-up option under the Settings tab. See below left. 
To be selectable in the Centreline Deviation Software, all CAN channels must be previously configured and set to log 
and ‘send over serial’ in the separate VBOX Tool Setup software. 
 
 
Once enabled the selected channels appear in the “Current Data” display window, see below right. 

 
Please note, the Centreline Deviation software configures your VBOX to 100Hz RS232 output. However, at this rate only certain 
channels are sent on the RS232 bus. If you choose to use RS232 rather than USB connection, you won’t be able to see all 
channels unless the user configures the VBOX to output serial data at 50Hz or less. This can be done in VBOX Setup via VBOX 
Tools software. 

 

 

  

If the window is green this 
indicates that the serial 
communication between the 
hardware and the software 
is successful, and that the 
VBOX has sufficient satellite 
lock. 

 

If the window is pink this 
means that either the 
connected VBOX has no 
satellite lock, or there has 
been a disruption in 
communication between the 
VBOX and software  
(No Comms).  

 Live data can also be 
monitored in the Current 
Data window, displaying 
Speed, satellite number, 
trigger status and up to four 
selected available CAN 
channels.   
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How to view Post Processed Data  

To generate deviation results from previously recorded data, the software must be set to Offline.  This can be done 
by clicking on the Options tab and ensuring that the Online option is unchecked. 
 

 
Load a VBO file in to the software by clicking on 
the File header tab at the top of the menu bar, 
and then clicking on Load.  
 
 

 
 
 
 
 
 
The loaded file will then automatically be scanned 
and the results displayed. 
 
 
 
 
 
 
 
 

Re-scanning Data 

Under the File tab there is a Rescan button that can be used at any time once a file has 
been loaded in.   
As it suggests, this button will re-scan the last loaded in data file and re-generate the 
results from it.  This can be particularly useful if a number of runs from the test had been 
removed (deleted) from the analysis window previously.   
 

 

Test Procedure & Setup 

Configuration of the setup criteria can be done using the Test 
Set-Up option, found under the settings toolbar.  
 
 
 
 
 
Adjust Units – The units for speed, distance and acceleration can all be changed.  These changes are reflected in all 
other windows in the software. 
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Start/Finish Lines – Load and save start/finish lines if testing in a specified location on different occasions. Gate 
width is the length of the start/finish line and can be adjusted to prevent accidental triggering. 
 

 
 
Start Condition – Choose between using a start line or trigger event to begin the test.* 
 

 
 
End Condition – Choose between a finish line or determine the distance that the test finishes and results are 
reported from.* 
 

 
 
Line Condition – Select this option if you wish to see the deviation at intervals on each run, the interval can be 
adjusted for a given distance depending on how many results are desired. 
 

 
 
 
Centreline Deviation – Adjust settings for centre line deviation computation. 
 
Full period duration - Time before trigger activation, this is what is used to calculate the centre line reference heading. 
 
Full Period std. dev. max – The maximum allowed heading deviation during test. 
 
Std. dev. Warning threshold – Heading deviation threshold before results displayed with red warning text. 
 
 
 
 
 
 
 
 
 
 

*Note Speed Sensor Units can only use a digital Input for the Start condition and centreline distance for the end of 
the test 
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Note: Centreline Deviation results in Red and Yellow: 
 

 
 
 
Obtaining Results 

Centreline Deviation test results can be achieved by using either a trigger or a GPS start line.  Once the software has 
detected one of these inputs it will calculate results for distance, centreline and other parameters relative to the 
user configured Test Setup. 

 

 

Testing environments 

Due to the dynamic nature of a centreline deviation test a VB3i (or equivalent RL unit) should be set to its highest 
dynamic, most sensitive settings.  To obtain good results from this it is essential that such a test is performed in an 
area of good, clear satellite reception (no high buildings, trees) with the antenna receiving a clear view to the sky 
with no obstructions (roof racks, etc). 

 
 

 
Analysing Results 

Results can be viewed and analysed in several forms using the Centreline 
Deviation Software package, and any graphs and tables can be adapted to 
suit the customers’ specific requirement for any given test.  
 
 
 
 
 

  

Centre line deviation results shown in Red indicates that the 
vehicle was not driven straight enough during the immediate time 
before the test start condition was met, exceeding the configured 
Full Period Standard Deviation threshold. Results shown in yellow 
indicate the standard deviation warning threshold has been 
exceeded. 
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Results from Last Recorded Test  

Results of the last performed brake stop test will be shown in numerical form in the Results Current Test tab, or in a 
more visual representation in the Current Graph window. The Current Graph shows the live plot of user configured 
channels for the current test run. 
The Current Graph window can be altered by making changes to the Current Graph Set-up page under the Settings 
option.  In the setup, both axis can be altered, different data channels be selected and a reset value determined. 
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Collective Results 

Figurative results are clearly laid out in a tabular form in the Results window. The test results by default will be 
shown in numerical order.  The table can be toggled though by clicking on a desired column to order the test results 
by highest to lowest (or reverse).  

 
 
 
 
Results can be visualised in the current graph tab, this can be modified in current graph setup to display any selected 
parameter. Colours can be applied to these by clicking on the names and selecting an appropriate colour to make the 
graph stand out..   
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  



Centreline Deviation Software Manual                                                                                             

 

11 14/02/2014 
 

The graphs are also adjustable using the Current Graph Set-Up option, under the Settings menu bar.  
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Removing Test Lines 

A practical tool within the software application is the ability to delete selected runs from the data output.  This 
enables any erroneous or unwanted results to be quickly removed from the data, making analysis clearer and more 
representable. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
If you wish to remove all of the current data, then the Reset button can be used to do 
this quickly. 
 

 

 

Exporting Test Results 

 
Click the Save Results tab to save the 
results out in an excel file with added 
comments to help reference the test 
results in the future.  
In the save file you are able to detail 
many conditions and vehicle variables 
from the set of results that have just 
been achieved. These comments are 
then amended to an excel document 
that includes the tabular results. 
Various inputs entered into this Save 
Data will be remembered by the 
software and be made available via a 
dropdown menu, for quick selection in 
any successive file saves.
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Glossary of Terms 

 

Centreline Deviation 

Commonly used for applications such as measuring side wind susceptibility, and vehicle deviation during various 
manoeuvres; the centre line deviation function can be used to show the deviation of a vehicle from a specified 
centre line to an accuracy of between 1 and 2cm (over a 30 second time period). 
 
The high accuracy, Doppler derived velocity channels are measured and used to determine the lateral deviation from 
a specified track heading at every sample using geometric theories.  This calculated deviation (lateral displacement) 
is an accumulative distance measurement, so it is most accurate when measured over short periods of time.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The above diagram simply displays how the accumulative deviation from a given centre line (H) is calculated. 
 
Once the centre line deviation value starts calculating (S1), it will initially take the heading value recorded by the 
Doppler shift, and create a heading difference value (h1), relative to the defined Centre line deviation heading.  
Knowing the velocity at which the vehicle was travelling between samples (v) allows a sample measured deviation 
distance to be accurately determined.  Using trigonometric relationships, this deviation distance is calculated using 
the following equation. 
 
 (Sin (heading diff) * Speed (m/s))*sample time  
 
For successive samples a heading difference is then determined by comparing the current heading sample to the one 
previous. 
   
The sample measured deviations are then accumulated throughout the test to produce a final centre line deviation 
result.  
 



Centreline Deviation Software Manual                                                                                             

 

14 14/02/2014 
 

Checking Software Version 

 

 
 
You can check what version of Brake Test Software you are currently using by clicking on the About tab along the top 
menu bar.   

 
 
Latest Software and Firmware versions are always available to download from our website. If you have any problems 
with Racelogic equipment please contact support@racelogic.co.uk. 
 
 
 
 

Contact details 

Racelogic 
Unit 10 Swan Business Centre 
Osier Way 
Buckingham 
Bucks MK18 1TB 
United Kingdom 
 
Email: support@racelogic.co.uk 
Web: www.velocitybox.co.uk 
  

http://www.velocitybox.co.uk/index.php/en/support/downloads-a-updates.html
mailto:support@racelogic.co.uk

